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InfView Overview

InfView is a general purpose Windows file Viewer that works with Windows 3.1, Windows for Workgroups,
Windows NT and the OS/2 Windows environment.

InfView allows you to view files in their true "Ascii" format as well as in a Hex/Ascii format similar to Dos 
Debug.

Unlike other file viewers, InfView has NO practical file size limit; the only limit is set by Windows providing 
memory to InfView to read and hold the file.    InfView reads the entire file into its Window so that 
displaying, searching and scrolling are instantaneous.    The only time a file is re-read is when you switch 
viewing modes (hex / ascii).

InfView will do string searches in Ascii View or string, hex or offset searches in the Hex View.    There is a 
one step Repeat Search menu item and keystroke to ease repeated searches through files.

InfView has a utility that will attempt to identify files based on either internal identifiers or on the file's 
extension.    Currently 50 different file types can be identified.

There is a menu option to execute the file that is being viewed.    If the file being viewed is a Dos or 
Windows program or Library, InfView will load and run that file, otherwise InfView will attempt to identify 
the file and then will attempt to load the application that uses that file.    In other words, if you are viewing 
ABC.WRD the Execute command will load Word for Windows with ABC.WRD already loaded.

Though InfView was written for "Informer" - The Windows Personal Information Manager, it can be easily 
be used with Windows File Manager and other Windows utilities to ease file viewing operations.

InfView will become an invaluable tool, so please register it and pass it on to colleagues and friends.



Loading InfView

InfView can be loaded:
- As an Icon from a Program Manager group.
- From the RUN feature of Program Manager or other Windows Shell programs.
- From Windows File Manager or other File Management utilities.

If you have added InfView to a group within Program Manager (or other shells) you can load InfView by 
Clicking on the Icon.    This will cause InfView to load and to request a file selection from an "Open File" 
dialog.

If you use the RUN facility within Program Manager (or other shells) you can load InfView with no files in 
its buffer by simply typing "INFVIEW" and pressing ENTER.    This will cause InfView to load and to 
request a file selection from an "Open File" dialog.

Note: The "Open File" dialog loads with the directory path of the file that was most recently loaded.    
This allows you to progressively view files within a directory without having to locate the Directory each 
time.

Optionally, you can enter a file name as a parameter to be passed to InfView, ie:    "INFVIEW    A.TXT" will
load InfView with the file A.TXT loaded within its buffer and ready to view.

Your final option for loading InfView is to have it automatically load with a file that is selected by Windows 
File Manager or other File Management utilities.    Windows File Manager maintains a table of file 
extensions and programs in the WIN.INI file under the "Extensions" heading.    If you want InfView to load 
every time a file with the extension of "TXT" is selected by File Manager, you would add a line to WIN.INI 
- Extensions showing: "txt=INFVIEW.EXE ^.txt".    For more information see the section on File Manager 
in your Windows manuals.

Other File Management utilities have similar options to load file viewers - however you should consult the 
documentation in order to determine the steps required in order to have InfView load automatically.

The "Informer" File Manager for which InfView was written has an option in SETUP to specify the file 
viewer.



Saved Configuration

Each time you run InfView it automatically saves several options that will be used when you next invoke 
InfView.    They are:

Position: If you move or resize the InfView Window, the last position before you close InfView is stored.    
When InfView is next invoked it will set itself to that last position.    This option allows you ensure that 
InfView loads to a particular area on your screen.

View Type: Whether the file you are viewing will be loaded initially in Ascii or Hex view type. (Menu option 
View - sub-menu options Ascii View or Hex View).

Editing Characters: Whether editing characters will be shown in an expanded way, including Tabs,CR, 
etc..(Menu option View - sub-menu options Do Not Expose or Expose).

Replace Non-Visible Characters: Whether non-visible characters will be replaced in the viewer with '~' 
(Menu option View - sub-menu option Replace Non-Visible).

Print Margins: The Margins you last set-up for printing from InfView. (Menu option Print)

Print Line Numbers: Whether or not your printed output has line numbers. (Menu option Print).

Print Page Numbers: Whether or not your printed output has page numbers. (Menu option Print).

Previously Viewed Files: InfView remembers the last 3 files that were viewed.    They are listed under the 
Files menu option and can be retrieved by selecting them directly from the menu.

Current Font: The currently selected font.

Current Font Size: The size of the currently selected font.

All of these options are saved in the INFORMER.INI file in your windows directory under the heading of 
[InfView].    InfView will automatically create the file if it does not exist and will insert the [InfView] heading
and the options automatically.



Closing InfView

You can close InfView by selecting the "Close" option from the System Menu or you can double click 
your mouse on the System Menu indicator at the top left corner of the InfView Window.

When you execute a file using the "Execute" menu option, InfView automatically shuts down after the file
is loaded.



The Viewing Window

When InfView is first loaded it will appear as a Window on your screen.    This window has several areas 
to which you have access:

The Menus
The Status Line
The File Viewer

The Menus

File - This option is used to Open New Files, Save Viewer contents to a file and to Close InfView.
Edit - Save selected text to the clipboard and other files.
Search - This option is used to invoke character or word searches within the Viewer area and then to 
repeat a subsequent search.
View - Used to toggle the Viewer contents between ASCII and HEX views.
Options - These options help configure InfView.
Print - This option allows for printing of the Viewer contents.
Execute - Will attempt to execute the File being Viewed.
Help - Access the InfView On-Line Help and the InfView Informational Windows.
Minimize and Maximize Buttons - Used to Minimize or Maximize the InfView Window. See the section on 
Minimizing and Maximizing the Viewer

The Status Line

The Status line appears directly below the Menu options and provides accurate information to aid you in 
using other InfView utility functions.

In ASCII View the Status line contains:
-The currently selected line number.
-The Offset from the beginning of the file of the first character in the currently selected line.
-The file size in characters.

In HEX View the Status line contains:
-The currently selected line number.
- The file size in characters and Hex bytes.

Note- Currently selected line number indicates the line number in the Viewer, not necessarily the line 
number of the file you are viewing.

The File Viewer

The File Viewer portion of the Window contains the contents of the file you are viewing in ASCII or HEX.    
The size of the Window will determine how much of the file (lines or columns) is actually shown at any 
given time.

Additional Topics:
View a Single Line in Hex
View the entire file in Hex
Minimizing and Maximizing the Viewer
Exposing Edit Characters
Replacing Non-Visible Characters
Changing the Font



View a Single Line in Hex

Rather than view an entire file in Hex, you have the ability to view any line from your Ascii View in Hex, 
regardless of the actual length of the line.    This tool is invaluable for determining whether there are any 
hidden or non-visible characters imbedded in your text.

To view a line in Hex, Double click your mouse on the particular line.

A Window will appear: InfView Hex Line Dump followed by the number of characters on the line you 
selected.

The window will contain lines of Hex values.    Each Hex value represents 1 character (byte) on the line 
and is seperated by a space from the next one.    Each line has 16 bytes translated on it.

When you are done viewing the line in Hex, click on the Ok button to return to the viewing window.



Toggle Ascii/Hex View

In order to toggle InfView between the Ascii view of a file and the Hex view of a file, select the View menu
option and then the appropriate Sub-Menu option.

InfView will completely re-read the current file when you toggle between Ascii and Hex views. Reading a 
file for Hex view will take considerably longer than reading a file for Ascii view.



Minimizing and Maximizing the Viewer

Minimizing InfView will reduce the viewing Window to an ICON at the bottom of your screen that 
indicates: Viewing: name.ext.    Double click your mouse on the ICON (or select it and press <Enter>) to 
restore it to its original size.

Maximizing InfView will enlarge the current viewing window to use the entire screen.    You should 
maximize when you are viewing files with more than 80 characters on a line. To restore the viewing 
window to its original size, click on the button in the upper right corner of the window (looks like 2 arrows 
on top of one another).

The Infview viewing window can be sized using the Size option on the system menu of InfView or you can
use standard Windows drag techniques to change the size.



Exposing Edit Characters

Edit characters include Carriage Returns, Line Feeds, Tabs, Back space, Form Feed, etc.    This option 
will allow to see these editing characters in an expanded form rather than in their non-visible form. You 
can use this option to inspect text for extra Editing characters.

To invoke this option, select the Option menu option followed by the Expose Editing Characters sub-
menu option.    A Checkmark will appear next to this sub-menu option.

To turn this option off, select the Option menu option followed by the Do Not Expose Editing 
Characters sub-menu option.    A Checkmark will appear next to this sub-menu option.

When this option is on, non-visible editing characters will be replace by:

Carriage Return - [CR]
Line Feed - [LF]
Back Space - [BS]
Tab - [TB]
Form Feed - [FF]
Vertical Tab - [VT]

The file is re-read and reformatted in the Viewing Window each time this option is turned on or off.

This option does not work in Hex View mode.



Changing the Font

InfView can be configured to display files in any available Windows Font, including TrueType.    When you 
change fonts InfView automatically remembers the change and uses the new font in subsequent viewing 
sessions.

To change the Font select the Options menu option and the select the Change Font sub-menu option.

After selecting a font and size from those available to you, select the Ok button to save the change and to
cause InfView to redraw using the new font.



Replacing Non-Visible Characters

When you are inspecting a text file looking for non-visible characters or when you are inspecting a binary 
file looking for visible characters, it is difficult to sift through all the non-visible and garbage characters.    
This option forces InfView to re-read the file and to replace all non-visible characters in the Viewing 
Window with a '~' character.

To invoke this option select the Option menu option followed by the Replace Non-Visible Characters 
sub-menu option.    A Checkmark will appear next to this sub-menu option and InfView will proceed to re-
read and reformat the file in the Viewing Window.

To turn this option off, follow the same steps.    The Checkmark will disappear from the menu.

This option does not work in Hex View mode.



Opening a Different File

When you want to view a different file, select the File menu option, then the Open File sub menu option.   
You will be shown the standard Windows "Open File" Dialog.    Select a path and file from this dialog and 
then select the "Ok" button to cause that file to be loaded.

If you select the "Cancel" button from the "Open File" dialog, you will return to the File Viewer Windows 
with the old file still loaded.

Note: The "Open File" dialog loads with the directory path of the file that was most recently loaded.    
This allows you to progressively view files within a directory without having to locate the Directory each 
time.

Additional Topics:
Opening Previously Viewed Files



Opening Previously Viewed Files

InfView remembers the last 3 files that were viewed.    The paths and names of these 3 files are stored in 
the INFORMER.INI file and are dynamically listed under the Files menu option.

Each time that a file is opened, both the Informer.Ini and the menu list are updated so that you can easily 
return to a previously viewed file without searching for it.

To open a previously viewed file select the Files menu option and then either double click your mouse on 
any of the previously viewed file names or press 1,2 or 3 on your keyboard to load the matching file.



Saving the Viewer to a File

This option allows to you to save the current contents (or a portion thereof) of the File Viewer into a File of
a different name.    You can save Hex views (or a portion thereof) as well.

To Save the Viewer contents, select the File menu option, then the Save Viewer Contents sub menu 
option.

The "Save" Dialog that will appear has the following options:

File Name - Enter the path and name of the file to which the Viewer contents will be saved.    If the file 
exists you will be asked to confirm the overwrite of the file prior to the Save operation being executed.

Heading - Enter an optional heading which will be written as the first line of the file.    This is useful in the 
case of saving Hex as a comment. (up to 60 characters).

Save From Line - Line 1 is automatically filled into this field. If you want the starting line number to be 
different, enter it here.

To Line - The line number of the last line in the File Viewer is filled in here.    If you want a different ending
line number, enter it here.

Browse Button - Select this button to invoke a "File Save" selection dialog which will allow you to 
traverse the hard disk (or network) for a specific path and file name.

Note: This option does not save files in their original format; it saves them in their viewed format.



Searching in the Viewer

The searching capabilities of InfView allow you to search for Characters, Words, Series of Words, Hex 
Values or Offsets.    InfView allows for an initial Search request and then allows for additional repetitions of
the same search.

What you can search for

In Ascii mode you can search for:

- Characters
- Words
- Groups of Words

In Hex mode you can search for: 

- Characters
- Words
- Groups of Words
- Hex sequences
- Offsets (in hex)

Starting a Search

To start a search select the Search menu option, then the Search sub menu option.

A Search window will appear asking you to enter the text you wish to search for (up to 50 characters in 
length).    You may also specify that the search will be case sensitive by selecting the Case Sensitive 
button.

When you have made your selections, click on the Ok button to start the search or click on the Close 
button to cancel the search.

Additional Topics:
Repeating a Search



Repeating a Search

Once an initial search has been made you can repeat the search to look for the Next occurance in the 
viewing window by clicking on the Search menu followed by clicking on the Repeat sub-menu, or you can
press F3 on your keyboard.

Subsequent repetitions of the search will continue until no more occurances are found in the viewing 
window upon which time you will be presented with the message No more occurances found.

Note: This search facility will only look for a single occurance of the search characters on any given line.



Searching the Disk for Files

This search facility is not unlike GREP or FILEFIND in the Dos environment.    You can find all occurances
of a particular File or File abstract across multiple directories, entire disks or even multiple disk network 
environments.

To invoke the File Search select the Search menu option, then the Search Disk for Files sub menu 
option. You can also press the F4 key on your keyboard to invoke the search.

The Disk Search entry screen will appear. The options on this screen are:

File Name to Search For: Enter the name and extension of the file(s) you wish to search for.    You can 
use wildcards and partial file names, ie: ABC*.TXT or WIN.* or FED*.*

Search Path: The default drive will appear in this field, however you can modify it to be any drive 
(including network) or any path within a drive.    The search will start with the Drive or Path you enter and 
will include all subdirectories.

Search All Drives If you select this option the search will proceed to search every drive on your network, 
starting with the root directory of each drive.

Prompt After Match If you select this option after each matching occurance is found a Messagebox 
appears indicating in which directory it was found and also gives you the option of terminating the search 
at that point.

After you have completed making your options, select the Start Search button to start the search (press 
Alt-S) or select the Close Search button to return to the InfView viewing window.

Additional Topics:
The Search list



Searching the Disk for Words/Characters

The Word Search facility of InfView will search all files in a particular directory, series of directories, disk 
or multiple disks for a given character, word or series of words.

To invoke the Word Search select the Search menu option, then the Search Disk for Words sub menu 
option. You can also press the F5 key on your keyboard to invoke the search.

The Disk Search entry screen will appear. The options on this screen are:

Word to Search For: Enter a character, series of characters, word or multiple words you wish to search 
for. Your entry can be up to 25 characters in length.

Search Path: The default drive will appear in this field, however you can modify it to be any drive 
(including network) or any path within a drive.    The search will start with the Drive or Path you enter and 
will include all subdirectories.

Search All Drives If you select this option the search will proceed to search every drive on your network, 
starting with the root directory of each drive.

Case Sensitive If you select this option then the search will only match your search criteria when all the 
case of each character matches exactly.

Prompt After MatchIf you select this option after each matching occurance is found a Messagebox 
appears indicating in which directory it was found and also gives you the option of terminating the search 
at that point.

After you have completed making your options, select the Start Search button to start the search (press 
Alt-S) or select the Close Search button to return to the InfView viewing window.

Additional Topics:
The Search list



Searching the Current Directory

The Directory search allows you to build a Search List containing all of the files in a given directory.    You 
can modify this search to search for particular file abstracts in a directory as well.

To invoke the Directory Search select the Search menu option, then the Search Directory sub menu 
option. You can also press the F6 key on your keyboard to invoke the search.

The Disk Search entry screen will appear. The options on this screen are:

Files To List: By default this field will show '*.*' indicating all files in the particular directory will be listed, 
however you can enter the name and/or extension of file(s) you wish to list in the directory, ie: ABC*.TXT 
or WIN.* or FED*.*

Search Path: The current directory will appear in this field, however you can modify it to be any directory 
on any drive available to you.    This search will not examine subdirectories of the current directory.

Additional Topics:
The Search list



The Search List

The Search List is a semi-permanent listing of files that matched the criteria you presented in the last Disk
Search.    The Search List can be revisited multiple times and can be used to load files directly into the 
viewer.

The Disk File Search, Word/Char Search and Current Directory search all share this list, so that the 
contents of the Search List will be replaced on each subsequent search by any of these 3 search types.

When you request a search (see the Search explanations) all the files that were found on your disk that 
matched the search are loaded into the search list.    If you select a file from the search list it will be 
loaded into the viewer.

The next time you request a search, the Search List will be intact until you actually start the search.

Additional Topics:
Loading the Next File from the Search list
Loading the Previous File from the Search list



Loading the Next File from the Search List

You can traverse the Search list in either direction to quickly view each file.

To Load the next file from the Search List select the Search menu option then select the Next Item from 
Search sub-menu item or press Ctrl-Tab on your keyboard.

After loading the last file in the Search List you will receive the message "You have reached the last 
item in the Search List".



Loading the Previous File from the Search List

You can traverse the Search list in either direction to quickly view each file.

To Load the previous file from the Search List select the Search menu option then select the Previous 
Item from Search sub-menu item or press Shift-Tab on your keyboard.

If you are viewing the First file in the Search List and attempt to view the Previous file, you will receive the
message "You have reached the first item in the Search List".



Going to a Line Number

You can move to a specific line of the viewing text by selecting the Search menu option followed by the 
Goto Line sub-menu option.

A window will appear indicating the range of line numbers in the Viewer.    In the Entry field where your 
cursor is initially positioned, type the line number to which you want the viewer to position itself.

If you enter a line number outside the allowable range, InfView will not change line positions.



Executing a File

Many times you will find yourself viewing a file and then wanting to execute it.    InfView provides a 
function that will execute many of the files that you will be viewing.

If the file you are viewing is an "EXE" "COM" "BAT" or "DLL" file, the "Execute" menu option will cause
the file to be loaded and run.    This includes Dos executables and Dos Batch files.

For any other type of file, InfView will search the "Extensions" table in your WIN.INI file looking for an 
application that matches the extension of the file you are viewing.    If an entry is found InfView will load 
the application and will pass the name of the file you are viewing to the application to load.

Caution with Dos Batch Files:  Dos Batch files will execute, however unless they require user input, 
control will immediately be returned to Windows, in fact you will probably only see your screen flash as an
indication that the batch file has run.    Any "Pause" or user input statements or program execution 
statements in the Batch file will continue and complete before returning control to Windows.

InfView automatically closes when it successfully "Executes" a file.



Identifying a File

InfView has the ability to identify a vast array of files based on either internal characteristics of the file or 
on the File Extension.    This ability is invaluable when you are unsure of the type of file you are viewing or
what application created or used the file.

To invoke the identification algorythm, select the File menu option and then select the Show Information 
sub-menu option.

Immediately a window will appear describing:

- The name of the file.
- The type of file. (identified either internally or through it's extension)
- Any Windows Associations that exist for this particular extension of file.    Associations are found in the 
WIN.INI file and are established using File Manager.
- The Size of the file in bytes and Kbytes.
- The Date of the last modification of the file.

Additional Topics:
Modifying the Identification List



Modifying the Identification List

In order to allow for flexibility and future expansion, InfView maintains a table of File Extensions and File 
descriptions.    You are able to modify this list at any time and once the modification is made, InfView will 
recognize the changes and utilize them in any attempts at file identification.

The list is maintained in the: INFORMER.INI file located in your Windows directory.

The INFORMER.INI file is used by all programs in the Informer series including this one, however the 
section you will be modifying within INFORMER.INI is used exclusively by InfView.

Using an Editor (or the INFORMER Configuration Editor) open the INFORMER.INI file.    Search for 
[Extensions] within the file.    InfView installs with approximately 75 Extension/Descriptions which should 
all be listed after the [Extensions] header.    The format of each entry in this list is: Extenion=Description,
ie: bat=DOS Batch File. You are not restricted in upper and lower case characters as a lookup for an 
extension is not case sensitive.

If you have 2 entries with the same extension but with different descriptions, InfView will only return the 
first entry.

Once you have modified the list, Save it!    InfView will immediately have access to the modifications.

Note: If you do not have an INFORMER.INI file or there is no [Extensions] section in your 
INFORMER.INI file you should reinstall InfView by running the SETUP.EXE file that is included on the 
diskette or in the INFVIEW.ZIP file you received.    If you do not have a SETUP.EXE file then your version 
of InfView may not be complete or current.    Contact us for a complete and current copy.



How to Stop InfView During a Long Read

When InfView is reading a large file, Windows must continually provide it with sufficient memory in order 
to put the entire file in memory and in the list box on your screen.

Depending on your system and on the amount of available memory and the size of your Windows swap 
file, you may find that InfView slows down reading large files (2 megabytes or so...) in Ascii View mode.    
However, in Hex View mode, each 16 bytes of disk file requires 80bytes of "viewing space" due to the fact
that the Offset, Hex code and Ascii code are all displayed on the screen.    In other words a 1.3meg file 
would require 6.5meg of Windows memory to load and view.

An indication of a slowdown due to Windows is the "Reading File : xx% complete" indicator that is at 
the top of the InfView window while the file is being read.    The percent complete will take several 
seconds to increment or may stop altogether while your disk shows activity.

You will probably not encounter this problem on systems with more than 4megs of memory and this 
problem will not happen on Windows NT or OS/2 systems.

Why does this happen?    Windows is trying to swap the contents of its memory to disk in order to 
provide InfView with the memory it requires.

What can I do? If you have to view an extremely large file, before running InfView on that file, shut down 
as many Windows applications as you can and unload any modules and Windows resident libraries. 

How do I stop InfView?    If InfView gets bogged down during a read, there is really only one way to 
abort the process, do a CTRL-ALT-DEL and select the option to "Terminate a task that is not responding" -
usually by pressing ENTER.    This will terminate InfView, free the Memory that InfView was requesting 
and then return you to Windows.



Printing a File

InfView can print files both in the Ascii and the Hex views.    You can print an entire file or just a portion 
and you can select limited formatting for your print job.

To print a file, select the Print menu option or press Alt P on your keyboard.

Additional Topics:
Printing Selected Text
Print Options
Selecting a Printer
Selecting a Communications Port



Printing Selected Text

When you select several lines of text, you can print it directly from InfView without Cutting it to another 
file.

After highlighting the selected text, select the Print menu option.    The Print Dialog will appear with the 
title "Print Selected Text" and the 'Print Selected Text, Lines: xx - xx' Button will be checked.

The range of lines that you selected will appear in the fields next to 'Print Selected Text, Lines:'. You can 
adjust the range, modify the print options or Start the print job.



Print Options

Before printing a file or a portion of the Viewing Window, you must select the various print options from 
the Print Request window.    They are:

Printer - see the section on Selecting a Printer

Printer Port - see the section on Selecting a Communications Port

Margins - The Left,Right,Top and Bottom margins can be modified so that your print page size can be 
adjusted.    Valid values are from 0-page size in inches and parts of inches.

Copies - Select the number of copies to print.

Print Lines - The values that are initially shown here are '1' and 'Number of Lines' in the text.    You may 
adjust these values to print only a portion of the file or Viewing Window.

Print Selected Text - If you only want a specific range of line numbers to print, select this button and enter 
the range of line numbers.

Print Line Numbers - If you select this field your output will have line numbers printed at the start of each 
line.

Print Page Numbers - If you select this field your output will have page numbers at the top of each page.



Selecting a Printer

The Print Request window will show you the currently selected printer in the Printer field.    If you want to
change to another available printer, click on the Select Printer button.

The Select Printer window will appear with a list of available printers as well as your current printer.    To 
select any of the available printers, Click your mouse on the selection, it will then appear in the Current 
Printer field.

Click on Ok button to save your change of printer, otherwise click on Cancel to exit without changing your
printer.

It is recommended that you Set up a printer that has been made active.    This can be done using the 
Setup button on either the Print Request window or the Select Printer window.    The setup for each 
printer will be different, consult the printer manual or the Windows manual for more information.



Selecting a Communications Port

You can change the communications port to which you will be printing.    This facility can let you print to a 
printer hooked to any valid port.    In addition, this option provides a means for you to print to a file.

In the Print Request window there will be a list of available ports and a field showing the port to which 
you are currently assigned, for example:

- LPT1:
- LPT2:
- LPT3:
- COM1:
- COM2:
- EPT:
- FILE:
- LPT1.OS2

To change ports, select the port to which you want to direct your output then double click your mouse on 
that selection.

When selected, the new port will appear in the Printer Port field.

Note: InfView or Windows will not ensure that a printer is connected to the port until such time as a file is 
printed.



The Hex Editor

InfView has an optional Hex Editor that will facilitate the modification of any type of file being viewed in 
Hex mode.

The Hex Editor can only be used in the Hex viewing mode and any modifications made in Hex mode will 
not appear in the Ascii mode unless the file has been saved.

To invoke the Hex Editor, Double Click on any Hex line in the viewer. The Hex Edit window will appear, 
displaying:

- The 16 Hex byte pairs
- The 16 Ascii bytes

You may now modify either the Hex or the Ascii values.    Once a change to either line is made, the other 
values will automatically be translated and modified to their new values, however this will only occur once 
there are 16 bytes to translate.

When you have completed your changes to the line, you may choose:

Ok - To update the viewer with the modified line.
Cancel - To return to the viewer without modifying the contents.
Restore - To restore the Hex Edit line to its original contents.

The Viewer will update the modified line only if the Ok button was selected.

If you attempt to:
- Change viewing modes.
- Load another file.
- Exit InfView.

after modifying the file, you will be notified that "The File has been modified, do you want to Save the 
changes".    If you reply Yes to this inquiry, the modifications will be saved to the file. (See "Saving a 
Modified File")

Additional Topics:
Saving a Modified File



Saving a Modified File

Once a file has been modified, the Save File sub-menu option under the File menu will be enabled.

To save the modified file select this sub-menu option.    The Save File screen will appear with the name of
the file being viewed as the Save file name.    Select Ok to accept the name and continue with the save 
process, or you may enter a different name or use the Directory tree structure to select a different name.

After selecting the file name, InfView will notify you if the file already exists.    You can accept the overwrite
request which will overwrite the existing file on disk with the contents of the Hex Viewer.



Keyboard Hot Keys

The following keyboard Hot Keys can be used to invoke various InfView functions immediately:

F1 - Help Index.
F2 - Start a word search within the Viewed file.
F3 - Repeat the last word search within the Viewed file.
F4 - Start a Disk File Search.
F5 - Start a Disk Word Search.
F6 - Build a list of all files in the current directory.

Ctrl-Tab - Load next file from Search list.
Shift-Tab - Load previous file from Search list.



Hex Translation Table

The following table shows all Visible or Control Characters.    Each line shows Decimal value - Hex value -
Character value:

00 - 00 - NUL 32 - 20 - SPC 64 - 40 - @ 96 - 60 - '
01 - 01 - SOH 33 - 21 - ! 65 - 41 - A 97 - 61 - a
02 - 02 - STX 34 - 22 - " 66 - 42 - B 98 - 62 - b
03 - 03 - ETX 35 - 23 - # 67 - 43 - C 99 - 63 - c
04 - 04 - EOT 36 - 24 - $ 68 - 44 - D 100 - 64 - d
05 - 05 - ENQ 37 - 25 - % 69 - 45 - E 101 - 65 - e
06 - 06 - ACK 38 - 26 - '&' 70 - 46 - F 102 - 66 - f
07 - 07 - BEL 39 - 27 - ' 71 - 47 - G 103 - 67 - g
08 - 08 - BS 40 - 28 - ( 72 - 48 - H 104 - 68 - h
09 - 09 - TAB 41 - 29 - ) 73 - 49 - I 105 - 69 - i
10 - 0A - LF 42 - 2A - * 74 - 4A - J 106 - 6A - j
11 - 0B - VT 43 - 2B - '+' 75 - 4B - K 107 - 6B - k
12 - 0C - FF 44 - 2C - , 76 - 4C - L 108 - 6C - l
13 - 0D - CR 45 - 2D - - 77 - 4D - M 109 - 6D - m
14 - 0E - SO 46 - 2E - . 78 - 4E - N 110 - 6E - n
15 - 0F - SI 47 - 2F - / 79 - 4F - O 111 - 6F - o
16 - 10 - DLE 48 - 30 - 0 80 - 50 - P 112 - 70 - p
17 - 11 - DC1 49 - 31 - 1 81 - 51 - Q 113 - 71 - q
18 - 12 - DC2 50 - 32 - 2 82 - 52 - R 114 - 72 - r
19 - 13 - DC3 51 - 33 - 3 83 - 53 - S 115 - 73 - s
20 - 14 - DC4 52 - 34 - 4 84 - 54 - T 116 - 74 - t
21 - 15 - NAK 53 - 35 - 5 85 - 55 - U 117 - 75 - u
22 - 16 - SYN 54 - 36 - 6 86 - 56 - V 118 - 76 - v
23 - 17 - ETB 55 - 37 - 7 87 - 57 - W 119 - 77 - w
24 - 18 - CAN 56 - 38 - 8 88 - 58 - X 120 - 78 - x
25 - 19 - EM 57 - 39 - 9 89 - 59 - Y 121 - 79 - y
26 - 1A - SUB 58 - 3A - : 90 - 5A - Z 122 - 7A - z
27 - 1B - ESC 59 - 3B - ; 91 - 5B - [ 123 - 7B - (
28 - 1C - FS 60 - 3C - < 92 - 5C -    124 - 7C - |
29 - 1D - GS 61 - 3D - = 93 - 5D - ] 125 - 7D - )
30 - 1E - RS 62 - 3E - > 94 - 5E - ^ 126 - 7E - ~
31 - 1F - US 63 - 3F - ? 95 - 5F - _ 127 - 7F - _

Character codes 128-255 (80-FF) are non-visible characters.



Revision History

Version 1.30 - 10/21/93
1. Correct menu offset problem on Last 3 files.
2. New Drive Search function to find Files (like FILE FIND).
3. New Drive Search function to find Words within files (like GREP).
4. New Directory Listing function to list all files in the current directory.
5. Added NEXT and PREVIOUS search list option to load files from the search list created from the above
3 functions.
6. Added Hot Keys for all of the above as well as F1 for Help.
7. Changed 'SHOW EDIT CHARS' to a single menu option with checkmark.
8. New Hex Editor (DEBUG) function to change Hex View of files and to save updated files back to disk.
9. TrueType flicker reduction by only painting changed lines of the viewer.
10. In Hex View Mode, Columns now line up for True Type fonts.

Version 1.20 - 10/07/93
1. Added ability to do Cut&Paste type operation to Copy selected text to the Clipboard.
2. Removed 'Identify' menu option and replaced it with a 'Show Information' sub-menu under 'Files'.    
Identifies files and shows File size & date.
3. Added 'Options' menu option and moved several 'View' options to it.
4. Added function to change the Font! Under the 'Options' menu you can select the Font for the Viewer. 
Font name and size are saved in INI and are used in subsequent sessions.
5. New 'Print Selected Text' dialog which will allow you to print text which you have selected.
6. Corrected bug which failed display text on memory boundaries.
7. Last Directory you were in is stored in the INFORMER.INI and is used during your next session for the 
'File Open' dialog.
8. New 'Goto Line' option under 'Search menu'.
9. Search positions the line where text was found at the top of the viewer window.

Version 1.10 - 09/30/93
1. Correction to Hex routine to show final Hex characters of a file.
2. Print Request screen allows specific line range to be printed.
3. The following user options are saved in INFORMER.INI under INFVIEW heading: Hex or Ascii View, 
Show Editing Characters and Translate Non-Visible characters.
4. List of file extensions and descriptions were moved from HARDCODED to a dynamic list within the 
INFORMER.INI    under EXTENSIONS heading.
5. The last 3 files viewed are saved and displayed under the FILES menu option and can be loaded 
directly from the menu.
6. You can save a range of lines to another file in Ascii or Hex.
7. The REPEAT search menu option can be invoked using the F3 key.
8. Menu option was added to expose editing characters in the viewed file, this includes CR,LF,TAB, etc...
9. Menu option was added to translate all non-visible characters to    the ' ~ ' character for the viewed file.
10. The size and position of the InfView window is remembered between viewing sessions so that it will 
be brought back in the same spot when it is next invoked.
11. The File IDENTIFY menu identifies the type of file and also attempts to determine if the file has any 
Windows associations on record.
12. InfView HELP was vastly expanded.
13. The Status line shows the Line Number and Starting offset of the line that is currently highlighted (as 
opposed to the first line in the window).
14. All Print Request options are stored in INFORMER.INI under the PRINT heading and are recalled 
each time Print is invoked. (also shared with other applications).15. In Ascii view mode, double clicking on
a line in the viewer will display the Hex translation of that particular line.
16. Hex Translation Table added to Online Help for reference.

Version 1.00 - 08/15/93
1.    First Version





Register this Program

This version of InfView is Unregistered.    You may use this program without restriction, however we 
expect (and hope) that if you like InfView that you will register the program with the authors.

To Register send a cheque or money order for $6.99 to:

Dean Software Design
P.O. Box 23311
Everett, WA 98203-0331

Note: Beginning October 10th you can now register this program using the CompuServe Shareware 
Registery Forum (Go SWREG, Registration id: 1414).    There is no additional cost to you! and you save a
Stamp and a Cheque!

Your registration will entitle you to:

1. A registered copy of the latest version of InfView.
2. Fully operational <unregistered> versions of other fine Shareware by Dean Software Design
3. Support.

Please specify the diskette media you prefer and allow 1-2 weeks for delivery.

Do you have any questions or comments? Send us an EMail on CompuServe address 75240,65.    We
will promptly get back to you!






